Legal Notices

This guide is copyrighted ©2009 by Avid Technology, Inc, with all rights reserved. Under copyright laws, this guide may not be duplicated in whole or in part without the written consent of Avid.

Documentation Feedback

At Avid, we’re always looking for ways to improve our documentation. If you have comments, corrections, or suggestions regarding our documentation, email us at techpubs@digidesign.com.

Disposal of Waste Equipment by Users in the European Union

This symbol on the product or its packaging indicates that this product must not be disposed of with other waste. Instead, it is your responsibility to dispose of your waste equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where you can drop off your waste equipment for recycling, please contact your local city recycling office or the dealer from whom you purchased the product.

Warning

⚠️ This product contains chemicals, including lead, known to the State of California to cause cancer and birth defects or other reproductive harm. Wash hands after handling.
Communications and Safety Regulation Information

Compliance Statement
This model Mbox 2 complies with the following standards regulating interference and EMC:
• FCC Part 15 Class B
• EN 55022 Class B
• EN 55204 Class B
• AS/NZS 3548 Class B
• CISPR 22 Class B

Radio and Television Interference
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules.

DECLARATION OF CONFORMITY
We Digidesign,
2001 Junipero Serra Boulevard, Suite 200
Daly City, CA 94014 USA
tel: 650-731-6300
declare under our sole responsibility that the product
Mbox 2
complies with Part 15 of FCC Rules.
Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Communication Statement
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try and correct the interference by one or more of the following measures:
• Reorient or locate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

Digidesign Mbox 2
FCC Tested To Comply with FCC Standards
FOR HOME OR OFFICE USE

Any modifications to the unit, unless expressly approved by Avid, could void the user’s authority to operate the equipment.
Canadian Compliance Statement:
This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

Australian Compliance

European Compliance

Digidesign is authorized to apply the CE (Conformité Européenne) mark on this compliant equipment thereby declaring conformity to EMC Directive 89/336/EEC and Low Voltage Directive 73/23/EEC.
Chapter 1. Welcome to Mbox 2 ................................................................. 1
  Mbox 2 Features .............................................................................. 1
  Pro Tools LE Capabilities ................................................................. 2
  System Requirements and Compatibility ........................................... 2
  Conventions Used in This Guide ....................................................... 3

Chapter 2. Installing Pro Tools on Mac .................................................. 5
  Installation Overview ........................................................................ 5
  Installing Pro Tools LE and Connecting Your Interface ......................... 5
  Launching Pro Tools LE ..................................................................... 7
  Additional Software on the Pro Tools Installer Disc ............................... 7
  Uninstalling Pro Tools ...................................................................... 8

Chapter 3. Installing Pro Tools on Windows ............................................. 9
  Installation Overview ........................................................................ 9
  Installing Pro Tools LE and Connecting Your Interface ......................... 9
  Launching Pro Tools LE ..................................................................... 12
  Additional Software on the Pro Tools Installer Disc ............................... 12
  Uninstalling Pro Tools ...................................................................... 14

Chapter 4. Configuring Your Pro Tools System ....................................... 15
  Starting Up or Shutting Down Your System ......................................... 15
  Configuring Pro Tools LE .................................................................. 16
  Optimizing a Mac System for Pro Tools ............................................ 23
  Optimizing a Windows System for Pro Tools ..................................... 25

Chapter 5. Mbox 2 Hardware Overview .................................................. 29
  Mbox 2 Front Panel Features ............................................................. 29
  Mbox 2 Back Panel Features .............................................................. 32
Chapter 6. Making Hardware Connections

- Connecting Headphones .............................................. 35
- Connecting a Sound System ............................................. 35
- Connecting a Recorder for Mixdowns ................................. 36
- Connecting Audio Inputs .................................................... 36
- Connecting a Microphone ................................................... 37
- Connecting Instruments to the Mbox 2 ................................. 39
- MIDI Connections .......................................................... 42

Appendix A. Configuring AMS (Mac OS X Only) ....................... 43

- Audio MIDI Setup .......................................................... 43
- MIDI Patch Name Support .................................................. 46

Appendix B. Configuring MIDI Studio Setup (Windows Only) ........ 47

- MIDI Studio Setup .......................................................... 47
- MIDI Patch Name Support .................................................. 49

Appendix C. Hard Drive Configuration and Maintenance .............. 51

- Avoid Recording to the System Drive ................................ 51
- Supported Drive Formats and Drive Types ............................ 51
- Formatting an Audio Drive ................................................... 52
- Partitioning Drives ............................................................. 53
- Defragmenting an Audio Drive ............................................. 54
- Using Mac Drives on Windows Systems ............................... 55
- Hard Disk Storage Space ..................................................... 56
Appendix D. Troubleshooting ................................................................. 57
  Backing Up Your Work ................................................................. 57
  Common Issues ................................................................. 58
  Performance Factors ................................................................. 58
  Before You Call Technical Support ........................................... 59

Appendix E. Resources ................................................................. 61
  About the Pro Tools Guides ...................................................... 61
  About www.digidesign.com ...................................................... 62

Index ......................................................................................... 63
Welcome to Mbox® 2 audio and MIDI production system.

Mbox 2 and Pro Tools LE® provide your USB-equipped computer with two channels of analog audio input and output, two channels of digital audio input and output, MIDI In and Out ports, analog monitor outs, and a headphone output with front panel level control. Mbox 2 provides professional-quality mic preamps and 24-bit analog-to-digital and digital-to-analog converters.

**Mbox 2 Features**

The Mbox 2 provides the following:

- Two channels of analog audio input with microphone preamps and switchable 48V phantom power
  - Analog input jacks include two XLR and two 1/4-inch connectors (one TRS, one TS), with switchable Mic, Line, and DI levels
  - –20 dB pad available separately on each analog input channel
- Two channels of S/PDIF digital input and output
  - S/PDIF inputs are available independently, in addition to analog inputs 1–2
  - S/PDIF outputs mirror analog outs 1–2
- Up to a total of four channels of input, using analog and digital inputs simultaneously
- One MIDI In and one MIDI Out port, providing 16 MIDI input channels and 16 MIDI output channels
- Two 1/4-inch TRS analog monitor outputs
- 24-bit A/D and D/A converters, supporting sample rates of 44.1 kHz and 48 kHz
- Zero-latency analog record monitoring with adjustable balance between input and playback
- Mono switch for enhanced monitoring of single-channel input sources (does not affect recording)
- 1/4-inch (TRS) stereo headphone output with adjustable level control
- USB-powered operation

⚠️ *Mbox 2 will not function properly if connected to a passive USB hub. If you need to use a hub for other USB peripherals, use a powered hub or a separate dedicated USB port for Mbox 2 to function properly.*
Pro Tools LE Capabilities

Pro Tools LE on Mac or Windows provides the following capabilities with Mbox 2:

- Playback of up to 48 mono or stereo digital audio tracks, or a combination of playing back and recording up to 48 mono or stereo digital audio tracks, depending on the capabilities of your computer.
- Up to 128 audio tracks (with up to 48 active tracks), 128 Auxiliary Input tracks, 64 Master Fader tracks, 256 MIDI tracks, and 32 Instrument tracks per session.
- 16-bit or 24-bit audio resolution, at sample rates up to 48 kHz.
- Non-destructive, random-access editing and mix automation.
- Audio processing with up to 10 inserts per track (RTAS® plug-ins or hardware inserts).
- Up to 10 sends per track.
- Up to 32 internal mix busses.

Pro Tools LE uses your computer’s CPU to mix and process audio tracks (host processing). Computers with faster clock speeds yield higher track counts and more plug-in processing.

System Requirements and Compatibility

Mbox 2 can be used with a qualified Windows or Mac computer running Pro Tools LE software.

A DVD drive is required to use the Pro Tools Installer disc.

We can only assure compatibility and provide support for hardware and software it has tested and approved.

For complete system requirements and a list of qualified computers, operating systems, hard drives, and third-party devices, refer to the latest information on our website:

www.digidesign.com/compatibility

MIDI Requirements

Mbox 2 includes one MIDI In port and one MIDI Out port, providing 16 channels of MIDI input and 16 channels of MIDI output.

If you require additional MIDI ports, add a MIDI interface to your system.

USB MIDI interfaces work effectively with Pro Tools systems on Windows or Mac. Serial MIDI interfaces are supported on Windows systems only.

Only USB MIDI interfaces are compatible with Pro Tools systems for Mac OS X. Modem-to-serial port adapters and serial MIDI devices are not supported.

For a list of supported adapters, visit our website at:

www.digidesign.com/compatibility
Hard Drive Requirements

For optimal audio recording and playback, all Pro Tools systems require one or more qualified drives.

For a list of qualified hard drives, visit our website:

www.digidesign.com/compatibility

If you are using an ATA/IDE or FireWire hard drive, initialize your drive with the Disk Utility application included with Apple System software (Mac) or the Windows Disk Management (Windows).

For more information, see Appendix C, “Hard Drive Configuration and Maintenance.”

Avoid Recording to the System Drive

Recording to your system drive is not recommended. Recording and playback on a system drive may result in lower track counts and fewer plug-ins.

Conventions Used in This Guide

Our guides use the following conventions to indicate menu choices and key commands:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Save</td>
<td>Choose Save from the File menu</td>
</tr>
<tr>
<td>Control+N</td>
<td>Hold down the Control key and press the N key</td>
</tr>
<tr>
<td>Control-click</td>
<td>Hold down the Control key and click the mouse button</td>
</tr>
<tr>
<td>Right-click</td>
<td>Click with the right mouse button</td>
</tr>
</tbody>
</table>

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The following symbols are used to highlight important information:

💡 User Tips are helpful hints for getting the most from your Pro Tools system.

⚠️ Important Notices include information that could affect your data or the performance of your system.

🔍 Shortcuts show you useful keyboard or mouse shortcuts.

➡️ Cross References point to related sections in this guide and our other guides.
This chapter contains information for Mac systems only. If you are installing Pro Tools on a Windows computer, see Chapter 3, “Installing Pro Tools on Windows.”

⚠️ Before installing this version of Pro Tools, refer to the Read Me information included on the Pro Tools Installer disc.

### Installation Overview

Installation of the Mbox 2 on a Mac includes the following steps:

3. Configuring your system for improved performance (see Chapter 4, “Configuring Your Pro Tools System”).
4. Making audio connections to the Mbox 2 (see Chapter 6, “Making Hardware Connections”).

💡 The Pro Tools Installer disc includes additional software for your system. For more information, see “Additional Software on the Pro Tools Installer Disc” on page 7.

### Installing Pro Tools LE and Connecting Your Interface

Before connecting your Pro Tools LE interface to the computer, you need to install Pro Tools LE software.

⚠️ Do not start this procedure with your Mbox 2 connected to your computer.

**To install Pro Tools LE on Mac OS X:**

1. Make sure you are logged in as an Administrator for the account where you want to install Pro Tools.

   ⚠️ For details on Administrator privileges in Mac OS X, see your Apple OS X documentation.

2. Insert the Pro Tools LE Installer disc in your DVD drive.

3. On the Installer disc, locate and double-click Install Pro Tools LE.mpkg.

Install Pro Tools LE.mpkg icon
4 Follow the on-screen instructions to proceed with installation.

5 Click Continue each time you are prompted.

6 At the Installation Type page, do one of the following:
   • To install all Pro Tools application files and free plug-in suites (and associated content), leave the default Installation options selected and click Continue.
   – or –
   • Select (or deselect) a custom configuration of Installation options (see “Installation Options” on page 6) and click Continue.

7 Click Install.

8 If prompted, enter your Administrator password and click OK to authenticate the installation.

9 Follow the remaining on-screen instructions.

10 When installation is complete, click Restart.

11 After the computer has started, connect the small end of the included USB cable to the USB port on Mbox 2 and connect the other end to any available USB port on your computer.

⚠️ If the USB LED on the front panel of the Mbox 2 does not illuminate, try unplugging the USB cable from the Mbox 2 USB port, and plugging it back in. If the USB LED still does not illuminate, shut down the computer, disconnect Mbox 2 and start the computer. Once the computer has fully restarted, reconnect Mbox 2.

⚠️ Mbox 2 may not function properly if connected to a USB hub. If you need to use a hub for other USB peripherals, connect the hub to a separate USB port; Mbox 2 must be connected to a dedicated port on the computer in order to function properly.

Installation Options

Pro Tools LE Options

To install a subset of Pro Tools software and plug-ins (and associated content), click the reveal triangle for the Pro Tools LE 8.0 option in the installer, and deselect any of the following options that you do not want installed.

Application Files (Required for Pro Tools) Installs the Pro Tools application and supporting library files needed to run Pro Tools. This option also installs the Digidesign CoreAudio Driver. This option must be selected to install Pro Tools.

DigiRack Plug-Ins Installs free plug-ins including DigiRack plug-ins, free Bomb Factory plug-ins, and Eleven Free, TL Utilities, D-Fi, and Maxim plug-ins.

Pro Tools Creative Collection Installs a set of free RTAS effects plug-ins and virtual instrument plug-ins (including 4.4 GB of associated sample content). For more information, see the Creative Collection Plug-ins Guide.

Additional Options

The Pro Tools installer provides the following additional options to install along with Pro Tools software and plug-ins.

Digidesign CoreAudio Driver This option installs the Digidesign CoreAudio Driver, which lets you use qualified audio interfaces with third-party applications that support the CoreAudio Driver standard.

Avid Video Engine This option lets you integrate Avid® video peripherals (such as the Avid Mojo® with your Pro Tools system).

MIDI I/O Driver The MIDI I/O™ Driver is required if you are using the Digidesign MIDI I/O interface.
Chapter 2: Installing Pro Tools on Mac

Launching Pro Tools LE

When launching Pro Tools LE the first time, you are prompted to enter an authorization code to validate your software. (The code begins with the letters DIGI.)

To authorize Pro Tools LE software:

1. Make sure Mbox 2 is connected to your computer.

2. Click the Pro Tools LE icon in the Dock (or double-click the application icon in the Pro Tools folder inside the Digidesign folder).

3. Enter the authorization code in the dialog (making sure to type it exactly as printed, and observing any spaces and capitalization), then click Validate. (Your authorization code is located on the inside front cover of this guide.)

4. Use the Quick Start dialog to do one of the following:
   - Create a new session from template.
   - Create a new blank session.
   - Open any other session on your system.

Additional Software on the Pro Tools Installer Disc

The Pro Tools LE Installer disc provides additional software for your system, including audio drivers (for playing other audio applications through your Digidesign hardware) and a Pro Tools demo session.

Third-Party Applications and Plug-ins

Your Pro Tools package also includes several free applications and plug-ins from selected third party developers. Once you’ve completed your Pro Tools installation, you can install these separately. Go to the Additional Files/3rd Party Content folder on the Pro Tools LE Installer disc.

Mbox 2 Factory Bundle Plug-ins

If you purchased a Factory version of Mbox 2, go to the Additional Files/Factory Bundle Installers folder on the Pro Tools LE Installer disc and run the Install Mbox 2 Factory Bundle installer.

Mbox 2 CoreAudio Driver

The Mbox 2 CoreAudio Driver is a multi-client, multichannel sound driver that allows CoreAudio compatible applications to record and play back through Digidesign hardware.

For more information on the Quick Start dialog and session templates, see the Pro Tools Reference Guide (Help > Pro Tools Reference Guide).

For information on configuring the Mbox 2 CoreAudio Driver, see the CoreAudio Drivers Guide.
Standalone Mbox 2 CoreAudio Driver

The Mbox 2 CoreAudio Driver can be installed as a standalone driver on Mac systems that do not have Pro Tools software installed. The standalone version of this driver is available on the Pro Tools Installer disc (in the Additional Files Folder).

For information on installing and configuring the standalone version of the Mbox 2 CoreAudio Driver, see the CoreAudio Drivers Guide.

Pro Tools Demo Session

The Pro Tools LE Installer disc includes a demo session that you can use to verify that your system is working.

The demo session for Pro Tool LE is named “Filtered Dream.”

Before installing the demo session to your audio drive, make sure the drive is configured as described in “Formatting an Audio Drive” on page 52.

To install the demo session:

1. Insert the Pro Tools LE Installer disc into your DVD drive.
2. On the Pro Tools LE Installer disc, locate and open the Additional Files/Demo Sessions Installer folder.
3. Double-click Install LE Demo Session.pkg.
4. Follow the on-screen instructions.
5. When prompted, select your audio drive as the install location and click Next to begin the installation. When installation is complete, click Close.

The demo session can be opened by double-clicking the Filtered Dream.ptf file (located in the Filtered Dream Demo Session folder).

Uninstalling Pro Tools

If you need to uninstall Pro Tools software from your computer, use the Uninstaller application.

To remove Pro Tools from your computer:

1. Make sure you are logged in as an Administrator for the account where Pro Tools is installed.

For details on Administrator privileges in Mac OS X, see your Apple OS X documentation.

2. Go to Applications/Digidesign/Pro Tools/Pro Tools Utilities and double-click Uninstall Pro Tools.
3. Click Continue to proceed with the uninstall.
4. Choose the type of uninstall you want to perform:

Safe Uninstall Leaves certain plug-ins and system files needed for compatibility with some Avid products. Use Safe Uninstall if you are using an Avid application or preparing to update to a CS (customer support) release.

Clean Uninstall Removes all Pro Tools files, including system files, Digidesign plug-ins, and MIDI patch names. Use Clean Uninstall whenever you are preparing to upgrade, or to troubleshoot from a clean system.

5. Click Uninstall.
6. Enter your Administrator password and click OK.
7. Click Finish to close the Installer window.
This chapter contains information for Windows systems only. If you are installing Pro Tools on a Mac computer, see Chapter 2, “Installing Pro Tools on Mac.”

⚠️ Before installing this version of Pro Tools, refer to the Read Me information included on the Pro Tools LE Installer disc.

### Installation Overview

Installing the Mbox 2 on a Windows computer includes the following steps:

2. “Launching Pro Tools LE” on page 12
3. Configuring your system for improved performance (see Chapter 4, “Configuring Your Pro Tools System”).
4. Making audio and MIDI connections to the Mbox 2 (see Chapter 6, “Making Hardware Connections” for details).

⚠️ The Pro Tools Installer disc includes additional software for your system. For more information, see “Additional Software on the Pro Tools Installer Disc” on page 12.

### Installing Pro Tools LE and Connecting Your Interface

Before connecting your Pro Tools LE interface to the computer, you need to install Pro Tools LE software.

⚠️ Do not start this procedure with your Mbox 2 connected to your computer.

**To install Pro Tools LE:**

1. Start Windows, logging in with Administrator privileges. For details on Administrator privileges, refer to your Windows documentation.
2. Insert the Pro Tools LE Installer disc in your DVD drive and do one of the following:
   - If Windows AutoRun is enabled, the installer splash screen will appear. Click the on-screen link to install Pro Tools LE. Then follow the on-screen instructions.
   - or -
   - If Windows AutoRun is disabled and the splash screen does not appear, double-click Setup.exe on the installer disc. Then click the on-screen link.
Follow the on-screen instructions to proceed with installation and click Next when prompted.

To install the complete compliment of Pro Tools software and plug-ins, leave Pro Tools selected.

At the Select Features page, do one of the following:
- To install all Pro Tools application files and free plug-in suites (and associated content), leave the default Installation options selected and click Continue.
- or –
- Select (or deselect) a custom configuration of Installation options (see “Installation Options” on page 11) and click Continue.

Click Next.

Click Install.

When prompted, connect the small end of the included USB cable to the USB port on Mbox 2. Connect the other end of the USB cable to any available USB port on your computer.

Mbox 2 may not function properly if connected to a USB hub. If you need to use a hub for other USB peripherals, connect the hub to a separate USB port; Mbox 2 must be connected to a dedicated port on the computer in order to function properly.

Click OK.

In Windows Vista, if the User Account Control dialog appears, click Allow.

In Windows XP, a series of Software Installation dialogs about the driver not passing Windows Logo testing may appear. Click Continue Anyway on each one until they go away.

If any other dialogs appear (such as the “Found New Hardware” dialog), leave them open and do not click on them. These dialogs will close on their own.

Wait for the installer to finish installing all software components, drivers, and PACE System files before proceeding to the next step.

When installation is complete, click Finish and restart your computer.

In Windows Vista, a series of Windows Security dialogs may appear. Click “Install” on each one until they go away.

If the USB LED on the front panel of the Mbox 2 does not illuminate after restarting the computer, try unplugging the USB cable from the Mbox 2 USB port, and plugging it back in. If the USB LED still does not illuminate, shut down the computer, disconnect Mbox 2 and start the computer. Once the computer has fully restarted, reconnect Mbox 2.
Installation Options

Pro Tools LE Options

To install a subset of Pro Tools software and plug-ins (and associated content), click the plus (+) next to Pro Tools LE 8.0 option in the Select Features page of the installer, and deselect any of the following options that you do not want installed.

Application Files (Required for Pro Tools) Installs the Pro Tools application and supporting library files needed to run Pro Tools. This option must be selected to install Pro Tools.

DigiRack Plug-Ins Installs free plug-ins including DigiRack plug-ins, free Bomb Factory plug-ins, Eleven Free, TL Utilities, and Digidesign D-Fi and Maxim plug-ins.

Pro Tools Creative Collection Installs a set of free RTAS effects plug-ins and virtual instrument plug-ins (including 4.4 GB of associated sample content). For more information, see the Creative Collection Plug-ins Guide.

Additional Options

The Pro Tools installer provides the following additional options to install along with Pro Tools software and plug-ins.

Mac HFS+ Disk Support Option This option lets your Pro Tools system read, write, record, and play back using Mac-formatted HFS+ disks. HFS+ disks are commonly referred to as Mac OS Extended disks.

Avid Video Engine The Avid Video Engine is required to use Pro Tools with Avid video peripherals such as the Avid Mojo.

Command|8 Controller and Driver The Command|8® driver is required if you are using the Digidesign Command|8 control surface.

Installing QuickTime

QuickTime is required for Pro Tools if you plan to include movie files, or import MP3 or MP4 (AAC) files in your sessions. QuickTime for Windows is available as a free download from the Apple website (www.apple.com).

⚠️ For information on which version of QuickTime is compatible with your version of Pro Tools, visit the compatibility pages of our website: www.digidesign.com/compatibility

To install QuickTime:

2. Download the QuickTime installer application to your computer.
3. Double-click the QuickTime installer application and follow the on-screen installation instructions.
4. Restart your computer.
Launching Pro Tools LE

When launching Pro Tools LE the first time, you are prompted to enter an authorization code.

To authorize Pro Tools LE software:

1. Make sure Mbox 2 is connected to your computer.

2. Double-click the Pro Tools LE shortcut on your desktop (or the application icon in the Pro Tools folder inside the Digidesign folder).

3. Enter the authorization code in the dialog (making sure to type it exactly as printed, and observing any spaces and capitalization), then click Validate. (Your authorization code is located on the inside front cover of this guide.)

4. Use the Quick Start dialog to do one of the following:
   - Create a new session from template.
   - Create a new blank session.
   - Open any other session on your system.

For more information on the Quick Start dialog and session templates, see the Pro Tools Reference Guide (Help > Pro Tools Reference Guide).

Additional Software on the Pro Tools Installer Disc

The Pro Tools LE Installer disc provides additional software for your system, including audio drivers (for playing other audio applications through your Digidesign hardware) and a Pro Tools demo session.

Third-Party Applications and Plug-ins

Your Pro Tools package also includes several free applications and plug-ins from selected third party developers. Once you’ve completed your Pro Tools installation, you can install these separately. Go to the Additional Files\3rd Party Content folder on the Pro Tools LE Installer disc.

Mbox 2 Factory Bundle Plug-ins

If you purchased a Factory version of Mbox 2, go to the \Additional Files\Factory Bundle Installers folder on the Pro Tools LE Installer disc and run the Mbox 2 Factory Bundle Setup.exe.

Windows Audio Drivers

The Digidesign ASIO Driver and WaveDriver Windows System Audio Driver let you use your Digidesign Mbox 2 hardware interface with third-party applications that support the ASIO Driver or WaveDriver MME (Multimedia Extension).

The Digidesign ASIO Driver and WaveDriver for Mbox 2 are automatically installed when you install Pro Tools.
Digidesign ASIO Driver

The Digidesign ASIO (Audio Sound Input Output) Driver is a single-client multichannel sound driver that allows third-party audio programs that support the ASIO standard to record and play back through Digidesign hardware.

For detailed information on configuring the Digidesign ASIO Driver, see the Windows Audio Drivers Guide.

Digidesign WaveDriver

(Windows XP Only)

The Digidesign WaveDriver Windows System Audio Driver is a single-client, stereo sound driver that allows third-party audio programs that support the WaveDriver MME (Multimedia Extension) standard to play back through Digidesign hardware.

For detailed information on configuring the Digidesign WaveDriver, see the Windows Audio Drivers Guide.

Standalone Windows Audio Drivers

Digidesign Windows Audio Drivers can be installed on Windows systems that do not have Pro Tools software installed. Use the standalone version of the Digidesign Windows Audio Drivers installer (Digidesign Audio Drivers Setup.exe), which is available on the Pro Tools LE Installer disc.

For information on installing and configuring the standalone version of the Digidesign Windows Audio Drivers, see the Windows Audio Drivers Guide.

Pro Tools Demo Session

The Pro Tools LE Installer disc includes a demo session that you can use to verify that your system is working.

The demo session for Pro Tool LE is named “Filtered Dream.”

Before installing the demo session to your audio drive, make sure the drive is configured as described in “Formatting an Audio Drive” on page 52.

To install the demo session:

1. Insert the Pro Tools LE Installer disc into your DVD drive.

2. On the Pro Tools LE Installer disc, locate and open the Additional Files\Demo Sessions Installer folder.

3. Double-click LE Demo Session Setup.exe.

4. Follow the onscreen instructions.

5. When prompted, select your audio drive as the install location and click Next to begin the install.

6. When installation is complete, click Finish.

The demo session can be opened by double-clicking the Filtered Dream.ptf file (located in the Filtered Dream Demo Session folder).
Uninstalling Pro Tools

Use the Uninstall Pro Tools application to uninstall Pro Tools software from your computer.

To uninstall Pro Tools from your computer:

1. Start Windows, logging in with Administrator privileges. For details on Administrator privileges, refer to your Windows documentation.

2. Go to C:\Program Files\Digidesign\Pro Tools\Pro Tools Utilities and double-click Uninstall Pro Tools.exe.

3. Click Next.

4. Click Uninstall to proceed with the uninstallation.
After you have connected your system and installed Pro Tools software, you are ready to start up and configure your Pro Tools system.

**Starting Up or Shutting Down Your System**

To ensure that the components of your Pro Tools system communicate properly with each other, you need to start them in a particular order.

**Start up your Pro Tools system in this order:**

1. Lower the volume of all output devices in your system.
2. Turn on any external hard drives. Wait approximately ten seconds for them to spin up to speed.
3. Turn on any control surfaces (such as Command|8).
4. Turn on any MIDI interfaces, MIDI devices, or synchronization peripherals.
5. Turn on your computer.
6. Launch Pro Tools or any third-party audio or MIDI applications.

**Shut down your Pro Tools system in this order:**

1. Quit Pro Tools and any other running applications.

   To quit Pro Tools, choose Pro Tools > Quit (Mac) or File > Exit (Windows).

2. Turn off or lower the volume of all output devices in your system.
3. Turn off your computer.
4. Turn off any MIDI interfaces, MIDI devices, or synchronization peripherals.
5. Turn off any control surfaces.
6. Turn off any external hard drives.
Configuring Pro Tools LE

Pro Tools System Settings

In the Playback Engine dialog, Pro Tools LE lets you adjust the performance of your system by changing system settings that affect its capacity for processing, playback, and recording.

In most cases, the default settings for your system provide optimum performance, but you may want to adjust them to accommodate large or processing-intensive Pro Tools sessions.

Hardware Buffer Size

The Hardware Buffer Size (H/W Buffer Size) controls the size of the buffer used to handle host processing tasks such as Real-Time AudioSuite™ (RTAS®) plug-ins.

- Lower Hardware Buffer Size settings are useful for improving latency issues in certain recording situations or for improving certain system performance problems. On Pro Tools LE systems, lower settings reduce all input-to-output monitoring latency on any record-armed tracks or Auxiliary Input tracks with live inputs.

- Higher Hardware Buffer Size settings are useful for sessions that are using more RTAS plug-ins for playback. These settings allow for more audio processing. They can also be useful to reduce errors on machines that require a higher buffer size.

⚠️ In addition to causing slower screen response and monitoring latency, higher Hardware Buffer Size settings can increase the latency caused by RTAS plug-ins, and affect the accuracy of plug-in automation, mute data, and MIDI track timing.

To change the Hardware Buffer Size:

2. From the H/W Buffer Size pop-up menu, select the audio buffer size, in samples.
3. Click OK.
RTAS Processors

The RTAS Processors setting determines the number of processors in your computer allocated for RTAS (Real-Time AudioSuite) plug-in processing.

With computers that have multiple processors, or that feature multi-core processing or hyper-threading, this setting lets you enable multiprocessor support for RTAS plug-ins. Used in combination with the CPU Usage Limit setting, the RTAS Processors setting lets you control the way RTAS processing and other Pro Tools tasks are handled by the system.

For example:

- For sessions with large numbers of RTAS plug-ins, you can allocate 2 or more processors to RTAS processing and set a high CPU Usage Limit.

- For sessions with few RTAS plug-ins, you can allocate fewer processors to RTAS processing and set a low CPU Usage Limit to leave more CPU resources available for automation accuracy, screen response, and video.

- Depending on the importance of video and overall screen response, and on the density of automation being employed, try different combinations of RTAS Processors and CPU Usage Limit settings to achieve the best results. For example, to improve screen response in a medium-sized session using a moderate number of RTAS plug-ins, try reducing the number of RTAS plug-ins, but keep the CPU Usage Limit set to the maximum (up to 99% on a single processor system).

To set the number of RTAS Processors:

2. From the RTAS Processing pop-up menu, select the number of available processors you want to allocate. The number of processors available varies depending on how many processors are available on your computer:
   - Select 1 Processor to limit RTAS processing to one CPU in the system.
   - Choose 2 Processors to enable load balancing across two available processors.
   - On systems running four or more processors, choose the number of processors for RTAS processing.
3. Click OK.

System Usage Window and RTAS Processing

The System Usage window (Windows > System Usage) displays the combined amount of RTAS processing occurring on all enabled processors with a single indicator, regardless of how many processors are available in the system. If the System Usage Window shows that you are at the limit of available resources, increase the number of RTAS processors and adjust the CPU Usage Limit setting.
CPU Usage Limit

The CPU Usage Limit setting controls the percentage of CPU resources allocated to Pro Tools host processing tasks. Used in combination with the RTAS Processors setting, the CPU Usage Limit setting lets you control the way Pro Tools tasks are carried out by the system.

- Lower CPU Usage Limit settings limit the effect of Pro Tools processing on other CPU-intensive tasks, such as screen redraws, and are useful when you are experiencing slow system response, or when running other applications at the same time as Pro Tools.

- Higher CPU Usage Limit settings allocate more processing power to Pro Tools, and are useful for playing back large sessions or using more RTAS plug-ins.

The maximum available CPU Usage Limit depends on the number of processors in your computer and on the number of processors you specify for RTAS processing. This value can range from 85% for single-processor computers, and 99% for multiprocessor computers (which dedicate one entire processor to Pro Tools).

On multiprocessor computers, the maximum CPU Usage Limit is reduced when you use all your processors (as selected in the RTAS Processing pop-up menu). For example, on dual-processors, the limit is 90%. On four-processor computers, the limit is 95%.

⚠️ Increasing the CPU Usage Limit may slow down screen responses on slower computers.

To change the CPU Usage Limit:

2. From the CPU Usage Limit pop-up menu, select the percentage of CPU processing you want to allocate to Pro Tools.
3. Click OK.

RTAS Engine (RTAS Error Suppression)

The RTAS Engine option determines RTAS error reporting during playback and recording. This is especially useful when working with instrument plug-ins.

You should only enable RTAS error suppression if you are experiencing frequent RTAS errors that are interrupting your creative workflow. When RTAS error suppression is enabled, you can experience a degradation of audio quality. However, this may be acceptable in order to avoid interrupting playback and recording when working with instrument plug-ins. Be sure to disable RTAS error suppression when you need to ensure the highest possible audio quality, such as for a final mix.

To enable RTAS error suppression:

2. Select Ignore Errors During Playback/Record.
3. On Mac, you can also select Minimize Additional I/O Latency.
4. Click OK.
RTAS Error Suppression Options

Ignore Errors During Playback/Record When enabled, Pro Tools continues to play and record even if the RTAS processing requirements exceed the selected CPU Usage Limit. This can result in pops and clicks in the audio, but does not stop the transport.

Minimize Additional I/O Latency (Mac Only) When enabled, any additional latency due to suppressing RTAS errors during playback and record is minimized to 128 samples. Suppressing RTAS errors requires at least 128 samples of additional buffering on some systems. If this option is disabled, the buffer is half the H/W Buffer Size, or at least 128 samples (whichever is greater). If you are on an older, slower computer, you may want to disable this option to avoid adverse performance.

This option is only available on Mac if the Ignore Errors During Playback/Record option is enabled.

DAE Playback Buffer Size

The DAE Playback Buffer Size setting determines the amount of memory DAE allocates for disk buffers. In addition to levels, the DAE Playback Buffer Size shows values in milliseconds, which indicate the amount of audio buffered when the system reads from disk.

The optimum DAE Playback Buffer Size for most disk operations is 1500 msec; Level 2 (Default).

- DAE Playback Buffer Size settings lower than 1500 msec; Level 2 (Default) may improve playback and recording initiation speed, as well as preview in context in DigiBase browsers. However, a lower setting may make it difficult to play or record tracks reliably with sessions containing a large number of tracks or a high density of edits, or with systems that have slower or heavily-fragmented hard drives.

- DAE Playback Buffer Size settings higher than 1500 msec; Level 2 (Default) allow higher track count, higher density of edits in a session, or the use of slower hard drives. However, a higher setting may increase the time lag when starting playback or recording, starting preview in context from DigiBase browsers, or cause a longer audible time lag while editing during playback.

💡 Using a larger DAE Playback Buffer Size leaves less system memory for other tasks. The default setting of 1500 msec (Level 2) is recommended unless you are encountering –9073 (“Disk too slow or fragmented”) errors.

To change the DAE Playback Buffer Size:


2. From the DAE Playback Buffer pop-up menu, select a buffer size. Memory requirements for each setting are shown at the bottom of the Playback Engine dialog.

3. Click OK.

If Pro Tools needs more system memory for the DAE Playback Buffer, it will prompt you to restart your computer.
**Cache Size**

The Cache Size setting determines the amount of memory DAE allocates to pre-buffer audio for playback and looping when using Elastic Audio.

**Minimum** Reduces the amount of system memory used for disk operations and frees up memory for other system tasks. However, performance when using Elastic Audio features may decrease.

**Normal** Is the optimum Cache Size for most sessions.

**Large** Improves performance when using Elastic Audio features, but it also decreases the amount of memory available for other system tasks, such as RTAS processing.

💡 Using a larger Cache Size leaves less system memory for other tasks. The default setting of Normal is recommended unless you are encountering -9500 (“Cache too small”) errors.

**To change the Cache Size:**

2. From the Cache Size pop-up menu, select a disk cache size.
3. Click OK.

---

**Plug-in Streaming Buffer Size**

(Structure Plug-in Only)

This setting appears in the Playback Engine dialog only if Structure, Structure LE, or Structure Free is installed on your system. The Plug-in Streaming Buffer Size determines the amount of memory DAE allocates for streaming playback from disk with the Structure plug-in. This setting only affects playback if disk streaming is activated in Structure's plug-in controls (see the **Structure Plug-in Guide** for more information).

The optimum Plug-in Streaming Buffer Size for most sessions is 250 ms (Level 2).

- Plug-in Streaming Buffer Size settings lower than 250 msec (Level 2) reduce the amount of system memory used for sample playback and frees up memory for other system tasks. However, audio quality of sample playback may decrease.

- Plug-in Streaming Buffer Size settings higher than 250 msec (Level 2) improve the audio quality of sample playback, but they also decrease the amount of memory available for other system tasks, such as RTAS processing.

💡 Using a larger Plug-in Streaming Buffer Size leaves less system memory for other tasks. The default setting of 250 ms (Level 2) is recommended unless you are experiencing problems with the audio quality of sample playback.

**To change the Plug-in Streaming Buffer Size:**

2. From the Plug-in Streaming Buffer Size pop-up menu, select a buffer size.
3. Click OK.
**Optimizing the Plug-in Streaming Buffer Size**  
*(Structure Plug-in Only)*

This option appears in the Playback Engine dialog only if one of the Structure sampler instrument plug-in is installed on your system. This option is useful when you are playing samples from the same drive that contains audio for the current session. When this option is selected, Pro Tools automatically optimizes the size of the Plug-in Streaming Buffer to facilitate disk access from both Pro Tools and Structure. The Plug-in Streaming Buffer Size pop-up menu is unavailable when this option is selected.

**To set Pro Tools to optimize the Plug-in Streaming Buffer Size:**

2. Select the Optimize for Streaming Content option.
3. Click OK.

---

**Pro Tools Hardware Settings**

In the Hardware Setup dialog, Pro Tools lets you set the default sample rate and clock source for your system, as well as a range of controls specific to each type of audio interface.

**Default Sample Rate**

The Sample Rate setting appears as the default sample rate when you create a new session. (This setting is available in the Hardware Setup dialog only when no session is open.)

*You can change the sample rate when creating a new Pro Tools session by selecting a different sample rate in the New Session dialog. (Refer to the Pro Tools Reference Guide for details.)*

**To change the default Sample Rate:**

1. Choose Setup > Hardware.
2. Select the sample rate from the Sample Rate pop-up menu.
3. Click OK.
**Clock Source**

The Pro Tools Hardware Setup dialog lets you select the Clock Source for the system.

**Internal** Use this setting if you are recording analog signals directly into Mbox 2 analog inputs 1–2 and/or are recording digital inputs into Mbox 2 inputs 3–4 where the digital device is synchronized to the Mbox 2 digital output.

**S/PDIF** Use this setting if you are recording through the Mbox 2 S/PDIF inputs from an external digital device. This setting will synchronize Pro Tools to that digital device.

**To select the Clock Source:**

1. Choose Setup > Hardware.
2. Choose the clock source from the Clock Source pop-up menu.
3. Click OK.

⚠️ Your digital input device must be connected and powered on for Pro Tools to synchronize to it. If your input device is not powered on, leave the Clock Source set to Internal.

**Configuring I/O Setup**

Using the I/O Setup dialog, you can label Pro Tools LE input, output, insert, and bus signal paths. The I/O Setup dialog provides a graphical representation of the inputs, outputs, and signal routing of the Mbox 2.

Pro Tools LE has default I/O Setup settings that will get you started. Use the I/O Setup dialog only if you want to rename the default I/O paths.

**To rename I/O paths in I/O Setup:**

1. Choose Setup > I/O.

2. Click the Input, Output, Insert, or Bus tab to display the corresponding connections.

3. To change the name of a path or subpath, double-click directly on the Path Name, type a new name for the path, and press Enter.

4. Click OK.

See the Pro Tools Reference Guide (Help > Pro Tools Reference Guide) for more information on renaming I/O paths.

**Configuring MIDI Setup**

If you plan to use any MIDI devices with Pro Tools, do one of the following:

- On Mac, configure your MIDI setup with Audio MIDI Setup. See Appendix A, “Configuring AMS (Mac OS X Only)” for details.

  — or —

Backing Up your System Configuration

After configuring your system and Pro Tools, you should save an image of your system drive using a backup utility such as Norton Ghost. By doing this, you can quickly restore your system configuration and settings if you encounter any problems.

Optimizing a Mac System for Pro Tools

To ensure optimum performance with Pro Tools, configure your computer before using Pro Tools hardware and software.

1. Choose System Preferences from the Apple menu and click Software Update.
2. Click the Scheduled Check tab and ensure Check for updates is deselected.

Turning Off Energy Saver

1. Choose System Preferences from the Apple menu and click Energy Saver.
2. Click the Sleep tab and do the following:
   - Set the computer sleep setting to Never.
   - Set the display sleep setting to Never.
   - Deselect Put the hard disk(s) to sleep when possible option.

Setting Processor Performance
(Mac G5 Computers and G4 Powerbooks Only)

1. Choose System Preferences from the Apple menu and click Energy Saver.
2. Click the Options tab and set Processor Performance to Highest.

For Windows System Optimization, see “Optimizing a Windows System for Pro Tools” on page 25.

Do not use the Mac OS X automatic Software Update feature, as it may upgrade your system to a version of Mac OS that has not yet been qualified for Pro Tools.

For details on qualified versions of Mac OS, refer to the latest compatibility information on our website (www.digidesign.com/compatibility).
Disable or Reassign Mac Keyboard Shortcuts Used by Pro Tools

To have the full complement of Pro Tools keyboard shortcuts, you need to disable or reassign any conflicting Mac OS X Keyboard Shortcuts in the Apple System Preferences, including the following:

- “Show Help menu”
- Under “Keyboard Navigation”
  - “Move focus to the window drawer”
- Under “Dock, Exposé, and Dashboard”
  - “Automatically hide and show the Dock”
  - “All windows”
  - “Application windows”
  - “Desktop”
  - “Dashboard”
  - “Spaces”
- Under “Spotlight”
  - “Show Spotlight search field”
  - “Show Spotlight window”

For a complete list of Pro Tools keyboard shortcuts, see the Keyboard Shortcuts Guide (Help > Keyboard Shortcuts).

To disable or reassign Mac OS X keyboard shortcuts:

1. Choose System Preferences from the Apple menu and click Keyboard & Mouse.

2. Click the Keyboard Shortcuts tab.

3. Do one of the following:
   - Deselect the Mac OS X options that conflict with Pro Tools keyboard shortcuts.
   - or -
   - Assign different, non-conflicting keyboard shortcuts to the corresponding Mac OS X options.

Reassign Spaces Keyboard Shortcuts

If you want to use Spaces, you should reassign the Spaces keyboard shortcuts to avoid conflicts with important Pro Tools keyboard shortcuts. You can reassign Spaces keyboard shortcuts to use a combination of modifier keys (Command+Option+Control+Shift) in addition to the default Spaces keyboard shortcut assignments to avoid these conflicts.

To reassign Spaces keyboard shortcuts to use modifier key combinations that do not conflict with Pro Tools keyboard shortcuts:

1. Choose System Preferences from the Apple menu and click Exposé & Spaces.

2. Click the Spaces tab.

3. Ensure that Enable Spaces is selected.

4. Press and hold Command+Option+Control+Shift and select “Control+Option+Shift+Command+F8” from the “To activate Spaces” pop-up menu.

5. Press and hold Command+Option+Control+Shift and select “Control+Option+Shift+Command+Arrow Keys” from the “To switch between spaces” pop-up menu.

6. Press and hold Command+Option+Control+Shift and select “Control+Option+Shift+Command+Number Keys” from the “To switch directly to a space” pop-up menu.
Disabling Spotlight Indexing

The Mac OS X Spotlight feature automatically indexes files and folders on local hard drives in the background. In most cases, this is not a concern for normal Pro Tools operation. However, if Spotlight starts indexing drives while recording in a Pro Tools session with high track counts for an extended period of time, it can adversely affect Pro Tools system performance. You may want to disable Spotlight indexing for all local drives before using Pro Tools for big recording projects.

⚠️ Disabling Spotlight indexing also disables the Find function in Mac OS X.

To disable Spotlight indexing:

1. Choose System Preferences from the Apple menu and click Spotlight.
2. In the Spotlight window, click the Privacy tab.
3. To prevent indexing of a drive, drag its icon from the desktop into the list.

Enabling Journaling for Audio Drives

To yield higher performance from audio drives, enable journaling.

To enable journaling:

1. Launch the Disk Utility application, located in Macintosh HD/Applications/Utilities.
2. Select the volume in the left column of the Disk Utility window.
3. Click Enable Journaling in the toolbar.

Optimizing a Windows System for Pro Tools

To ensure optimum performance with Pro Tools LE, configure your computer before using Pro Tools hardware and software.

⚠️ For Mac System Optimization, see “Optimizing a Mac System for Pro Tools” on page 23.

Before configuring your computer, make sure you are logged in as an Administrator for the account where you want to install Pro Tools. For details on Administrator privileges, see your Windows documentation.

Required Optimizations

To ensure optimum performance with Pro Tools, configure the following settings before using Pro Tools hardware and software.

⚠️ When you are finished changing Windows system settings, restart your computer.

Enabling DMA

Enabling your computer's DMA (Direct Memory Access) frees up CPU bandwidth so your computer can do other Pro Tools tasks.

In most cases the DMA option will already be set correctly, as Windows detects and activates DMA mode by default.
To enable DMA for any IDE hard drives:

1. Right-click Computer (Windows Vista) or My Computer (Windows XP).
2. In the left-hand pane of the Computer Management window under System Tools, click on Device Manager.
3. In the right-hand pane, click the plus (+) sign to expand IDE ATA/API Controllers.
4. Right-click on the Primary IDE Controller and select Properties.
5. Click the Advanced Settings tab.
6. For each device, do one of the following depending on your operating system:
   - Check the box Enable DMA (Windows Vista)
   - or –
   - Set the Transfer Mode to DMA if available (Windows XP)
7. Click OK.
8. Repeat the above steps for any additional IDE Channels.

Disabling System Standby and Power Management

When using Pro Tools, the Windows System Standby power scheme must be set to Always On. This helps prevent long record or playback passes from stopping due to system resources powering down.

To configure Windows Power Management (Windows Vista):

1. Choose Start > Control Panel.
2. Double-click Power Options.
3. In the Power Options window, select High Performance.
4. Click Change plan settings.
5. In the Edit Plan Settings window, click Change advanced power settings.
6. In the Power Options dialog, reveal Hard disk > Turn off hard disk after.
7. Click the Setting option.
8. Select the value in the Setting (Minutes) field and press Backspace on your computer keyboard.
9. Press Enter. The hard disk setting changes to Never and the Power Options dialog closes.
10. In the Edit Plan Settings window, click Save changes and close the window.

To configure Windows Power Management (Windows XP):

1. Choose Start > Control Panel.
2. Double-click Power Options.
3. Click the Power Schemes tab.
4. From the Power Schemes pop-up menu, select Always.
5. Verify that the following settings are set to Never:
   - Turn off hard disks
   - System standby
   - System hibernates
6. Click OK.
Disabling User Account Control  
(Windows Vista Only)

For optimal performance with Pro Tools on Windows Vista, disable User Account Control (UAC).

To disable User Account Control (UAC):
1. Choose Start > Control Panel.
2. Double-click User Accounts.
3. Click Turn User Account Control on or off.
4. Deselect the Use User Account Control (UAC) to help protect your computer option.
5. Click OK.

Recommended Optimizations

Pro Tools can also be affected by other software and hardware drivers installed on your computer. For best possible performance, it is recommended (but not required) that you do the following:
- Avoid running any unneeded programs at the same time as Pro Tools.
- Turn off any software utilities that run in the background, such as Windows Messenger, calendars, and disk maintenance programs.
- Turn off any non-essential USB devices while running Pro Tools.
- If your video display card supports it, enable Bus Mastering in the manufacturer's Control Panel. See the manufacturer's instructions for details.

Optional Optimizations

The following system optimizations may help Pro Tools perform better on some systems. It is recommended that you only try these optimizations if necessary, as they may disable or adversely affect the functionality of other programs on your system.

Disabling Network Cards

If applicable, disable any networking cards (other than a FireWire card that you might use to connect an external drive to your system).

To disable a network card:
1. Right-click Computer (Windows Vista) or My Computer (Windows XP) and choose Manage.
2. Under System Tools, select Device Manager.
3. In the Device Manager window, double-click Network adapters, then double-click the Network Adapter card you want to disable.
4. Under the General tab, choose “Do not use this device (disable)” from the Device Usage pop-up menu, and click OK.
5. Close the Computer Management window.
Adjusting Processor Scheduling

To adjust Processor Scheduling performance:

1. Right-click Computer (Windows Vista) or My Computer (Windows XP) and choose Properties.
2. In the System Properties window, click the Advanced tab.
3. Under the Performance section, click the Settings button.
4. In the Performance Options window, click the Advanced tab.
5. Under the Processor Scheduling section, select the Background Services option.
6. Under the Memory Usage section, select the System cache option.
7. Click OK to close the Performance Options window.
8. Click OK to close the System Properties window.
9. Restart the computer for the changes to take effect.

Disabling System Startup Items

The fewer items in use by your computer, the more resources are available for Pro Tools. Some startup applications may be consuming unnecessary CPU resources, and can be turned off.

If you disable any of the following startup items, do so carefully:

- Portable media serial number (required for some applications that utilize a copy protection key)
- The Plug and Play service
- Event log
- Cryptographic services

To Disable System Startup Items:

1. From the Start menu, type “msconfig” in Start Search (Windows Vista) or in Run (Windows XP) and click OK to open the System Configuration Utility.
2. Under the General tab, choose Selective Startup.
3. Deselect Load Startup Items and click OK.
4. Click Restart to restart the computer.
5. After restarting, the computer displays a System Configuration message. Check to see if Pro Tools performance has increased before you deselect the Don't show this message again option. If performance has not changed, run “msconfig” and return your computer Startup Selection back to Normal Startup - load all device drives and services. Alternatively, try disabling Startup items and non-essential processes individually.
Mbox 2 Front Panel Features

Figure 1 identifies controls, indicators, and input and output ports on the front panel on the Mbox 2.

The Mbox 2 front panel provides the following:

**S/PDIF LED**

This LED indicates that Mbox 2 is using the S/PDIF inputs as the clock source. See “S/PDIF Digital I/O” on page 32.

**USB LED**

The USB LED indicates that the Mbox 2 has received power from its USB connection. Once the USB light is on, audio can pass in or out of the system.

**Front Panel Headphone Output**

Use the Headphone Output to connect stereo headphones with a 1/4-inch stereo connector.

**Headphone Level**

The headphone knob adjusts the output level of the Headphone port, which outputs the signal that is routed to Outputs 1–2 in Pro Tools LE, and mirrors the Monitor Output ports.
Monitor Level

The Monitor knob adjusts the output level of the Monitor Output ports. In Pro Tools, this will be the signal routed to Outputs 1–2.

Mix (Ratio) Control

Mbox 2 gives you the ability to monitor your analog input signals while recording, without the delay incurred by A/D/A converters and host-based processing.

This zero-latency analog monitoring is controlled with the Mix knob, which you can use to blend and adjust the monitor ratio between Mbox 2 analog inputs and Pro Tools playback. The Mix knob has no effect when you are using S/PDIF digital inputs, since it controls the signal before it reaches the A/D converters.

To listen to just the Source input signal, turn the Mix knob fully left to Input. To listen to Pro Tools output only, turn the knob fully right to Playback.

The output from the Mix control is routed directly to the Monitor outputs, and is mirrored in the Headphone and S/PDIF output ports.

This ability to blend and control the relative levels of Pro Tools playback and latency-free live analog inputs can be particularly effective when overdubbing.

Mono Switch and LED

The Mono switch sums the input channels to a mono signal (delivering that identical signal to both speakers). This has no effect on Pro Tools playback monitoring, recording, or on the main outputs. Switching your stereo source signal to mono is useful when you are recording a mono input while listening to stereo playback (to hear your playing in both sides), or for checking the phase relationship of stereo inputs. When engaged, the Mono LED lights.

Monitoring while Overdubbing

By panning signals to the center or using the Mono switch, as opposed to panning them hard left and right in the Headphone outputs, you can create a more focused monitor mix to help minimize distractions while overdubbing.

In situations where you are monitoring stereo microphones, stereo synthesizers, or any source pairs with a comfortable balance, you will probably not want to use the Mono switch.

Checking Phase Relationships

The Mono switch can also be used for a quick check of the phase relationship between Source 1 and Source 2 inputs.

When the two input signals are out of phase, pressing the Mono switch will result in a sudden “hollow” sound that is the result of phase cancellation. This quick test with the Mono switch can help to avoid phase problems later when mixing these tracks. Frequent checking of phase relationships with the Mono switch can also assist you in finding the optimal microphone placement.
48V Switch and LED

Phantom power is activated by the switch labeled 48V on the front panel of Mbox 2. The LED, when lit, indicates that 48V phantom power is active on the Mic/Line inputs. These inputs provide phantom power for microphones that require it to operate.

About Phantom Power

*Dynamic* microphones (such as a Shure SM57) do not require phantom power to operate, but are not harmed by it. Most *condenser* microphones (like an AKG C3000) do require phantom power to operate.

⚠️ **Although phantom power can be used safely with most microphones, it is possible to damage some ribbon microphones with it. Always turn off phantom power and wait at least ten seconds before connecting or disconnecting a ribbon microphone.**

⚠️ **When using phantom power, Mbox 2’s maximum current per microphone is 4 mA.**

If you are not sure about the phantom power requirements for your microphone, consult your microphone’s documentation or contact the manufacturer.

Peak LEDs

These LEDs are clip indicators. If the Peak LEDs flicker occasionally, the signal reaching Mbox 2 has clipped.

Gain Controls

These knobs adjust the input gain levels of the Mic/Line inputs.

Pad Switches and LEDs

The Pad switches engage a –20 dB pad on their corresponding input channels. When engaged, the Pad LEDs light.

Mic/DI Source Selectors and LEDs

These switches select either the Mic (XLR) and Line (TRS) inputs or DI inputs for each channel. The Mic and DI LEDs indicate the current source input.

Removable Handle

Mbox 2 includes a handle that can be used for carrying and tilting, as well as a replacement panel that makes the unit more compact.

- The handle can be used as a stand that tilts the unit into a more easily viewable angle when the Mbox 2 is placed on a desktop. The handle can also be used to carry the unit.

- The handle can also be replaced with the optional Mbox 2 faceplate panel. This panel lets Mbox 2 sit flat on a desktop, and reduces the space required when packed for traveling.

To replace the handle with the Mbox 2 panel:

1. Unscrew the handle mounting screw located along the right edge of the handle (when viewing from the front).
2. Remove the handle.
3. Mount the replacement panel in position where the handle had been.
4. Secure the panel to the unit in its new position using the same screw you removed in step 1.
5. Repeat the above basic instructions to replace the panel with the handle.

Although phantom power can be used safely with most microphones, it is possible to damage some ribbon microphones with it. Always turn off phantom power and wait at least ten seconds before connecting or disconnecting a ribbon microphone.

When using phantom power, Mbox 2’s maximum current per microphone is 4 mA.
Mbox 2 Back Panel Features

Figure 2 identifies each port on the back panel of the Mbox 2.

Figure 2. Mbox 2 back panel

The Mbox 2 back panel provides the following:

USB Port

This standard USB v1.1 connector is used to connect your computer to the Mbox 2. One standard USB cable is included with your system.

The Mbox 2 is compatible with USB 2.0 ports. However, the USB 2.0 bus will switch to the slower USB v.1.1 speed to accommodate Mbox 2.

MIDI I/O

The MIDI In and MIDI Out ports are standard 5-pin MIDI ports, each providing 16 channels of MIDI input and output.

S/PDIF Digital I/O

The S/PDIF in and out ports are unbalanced two-conductor phono (RCA) connectors that utilize a full 24-bit, two-channel digital data stream.

The Sony/Philips Digital Interface Format (S/PDIF) is used in many professional and consumer CD recorders and DAT recorders. To avoid RF interference, use 75-ohm coaxial cable for S/PDIF transfers and keep the cable length to a maximum of 10 meters.

In use, the S/PDIF input channels are available in addition to the two channels of analog audio input. This lets Mbox 2 be used as a 4-in/2-out digital audio interface for Pro Tools LE.

The S/PDIF output channels always mirror the main outs 1–2.
Mon Out (Monitor Output)

These outputs support balanced TRS, or unbalanced TS, 1/4-inch connections. To monitor your mix, these outputs can be connected to a mixing board, directly to a monitoring system such as a stereo power amp, or another stereo destination.

The Mon Out Left and Right play the audio that is routed to analog outputs 1 and 2 from within Pro Tools, respectively. These analog outputs feature 24-bit digital-to-analog converters.

Input 1 and Input 2

Each analog source input channel (Input 1 and Input 2) provides Mic, DI (“Direct Inject”), and Line (TRS) ports. These balanced/unbalanced analog audio inputs support a broad range of input levels, as follows:

- Mic (microphone) for XLR inputs
- Line (TRS) for line level signals on TRS or TS inputs
- DI for other 1/4-inch TRS or TS connections

On the front panel, the input signal is adjusted by the Gain control for each channel and the source (Mic/Line, or DI) is chosen using the Source selectors.

Though the XLR connectors support instrument and microphone level inputs, whenever a TRS cable is plugged in to the Line(TRS) port, the XLR port on that channel is ignored.
To hear audio recorded into a Pro Tools session, you will need to connect headphones or an external sound system (such as powered monitors or a home stereo) to Mbox 2. Sound from Mbox 2 cannot be played through your computer’s speakers or your computer’s sound output.

**Connecting Headphones**

On the front panel of the Mbox 2 is a 1/4-inch jack to connect headphones, and a headphone level control to adjust headphone volume.

**To connect headphones:**
- Connect headphones with a 1/4-inch stereo connector (or adapter) to the Headphone jack.

![Headphone level](image)

**Headphone jack on front of Mbox 2**

**Connecting a Sound System**

The monitor outputs on the back of the Mbox 2 support 1/4-inch plugs. These connections can be balanced, TRS (Tip, Ring, Sleeve) style connectors, or unbalanced connectors. To listen to your Pro Tools session, these outputs can be connected to any amplification system: powered speakers, a home stereo system, or a mixer.

When connecting to a stereo system, connect the left channel (often the white plug) to Mon Out Left, and right channel (often the red plug) to Mon Out Right.

![Monitor Out Left and Right](image)

**Stereo output from the Mbox 2 (back panel)**

Mon Outs Left and Right play the audio that is routed to analog outputs 1 and 2 within Pro Tools.

*Home stereo systems often use RCA connectors. You can use an adaptor or a special cable to convert from the TRS or TS connectors used by Mbox 2 to the RCA connectors on your home stereo.*
Connecting a Recorder for Mixdowns

After you record and mix your sessions in Pro Tools, you may want to mix them down to a DAT, CD recorder, Mini-Disc, or other stereo 2-track recording device.

Connecting an Analog Deck

Connect the left and right Mon Outs on the back of the Mbox 2 to your recorder’s analog inputs. Mon Outs Left and Right should be routed to the left and right inputs, respectively, on your recorder. These outputs are TRS ports. You may need adapter cables if your mixdown deck has RCA inputs.

Connecting a Digital Deck

If you have a CD recorder, DAT deck or other device that accepts S/PDIF connections, connect it to the S/PDIF In and S/PDIF Out RCA ports on the back of Mbox 2.

💡 When recording from Pro Tools to a digital device, make sure the Pro Tools Clock Source setting is set to Internal clock mode.

Connecting Audio Inputs

This section describes the analog inputs available on Mbox 2. For information about connecting specific audio sources, see “Connecting a Microphone” on page 37, and “Connecting Instruments to the Mbox 2” on page 39.

Overview of Analog Inputs

Mbox 2 inputs (sources) support microphones, guitars, keyboards, and other types of instruments. Mbox 2 has two audio input sections, labeled Input 1 and Input 2. For stereo inputs, use Input 1 for the left input, and Input 2 for the right input.

The two input sections are located so that the hardware input jacks line up directly behind their corresponding input controls on the front panel. This makes it easier to locate channel input connections from the front.
Each Input section has three analog input jacks:

**Mic** For XLR microphone cables.

**Line (TRS)** For 1/4-inch Tip-Ring-Sleeve cables from keyboards, mixers, microphones, and other line sources.

**DI** For 1/4-inch Tip-Sleeve cables from guitar, bass, microphones, or similar sources.

For information about connecting specific audio sources, see “Connecting a Microphone” on page 37, and “Connecting Instruments to the Mbox 2” on page 39.

### Connecting a Microphone

There are several ways to use Mbox 2 with a microphone, depending on the type of microphone and cable you use.

### Mic Cables and Connectors

Some microphone cables use an XLR connector to attach a microphone to an input (such as those on the Mbox 2); other microphones use a 1/4-inch connector. If you have a choice, use an XLR connector to connect the microphone to the Mbox 2 to yield better results.

---

**Phantom Power**

Some microphones require power to operate. This power, called *phantom power*, is supplied either by a battery in the microphone, or through an audio interface (such as Mbox 2) that can supply power through the microphone cable.

Most *condenser* microphones (such as an AKG C3000) require phantom power to operate. *Dynamic* microphones (such as a Shure SM57) do not require phantom power to operate, but are not harmed by it.

> **Warning**: Although phantom power can be used safely with most microphones, it is possible to damage some ribbon microphones with it. Always turn off phantom power and wait at least ten seconds before connecting a ribbon microphone.

The Mbox 2 can only supply power through a microphone cable with XLR connectors. If you are not sure about the phantom power requirements for your microphone, refer to your microphone’s documentation or contact the manufacturer.
Using a Mic that Has an XLR Connector

To use a microphone that has an XLR connector:

1. Plug your microphone cable into one of the Mic inputs on the back of Mbox 2.

2. Make sure nothing is plugged in to the Line (TRS) jack, otherwise Mbox 2 will use audio from the Line (TRS) input and not the Mic input.

3. Set the Source to Mic (microphone) by pressing the Mic/DI Source selector on the front of Mbox 2 until the Mic LED is lit.

4. If your microphone requires phantom power, make sure the microphone is connected, then press the Phantom Power switch (labeled 48V) on the front of the Mbox 2. This switch sends 48V to both mic inputs. The 48V LED on the front of the Mbox 2 will light when phantom power is being supplied.

5. On the front of the Mbox 2, turn the Mix control fully left to Input.

6. On the front of the Mbox 2, carefully turn the Gain control to the right to increase the input level of your microphone signal.

7. If the incoming signal is too loud, press the Pad switch to engage the –20 dB pad.
Using a Mic that Has a 1/4-Inch Connector

To use a microphone that has a 1/4-inch TS (Tip-Sleeve) connector:

1 On the back of the Mbox 2, plug the 1/4-inch connector from your microphone into one of the DI inputs.

2 On the front of the Mbox 2, set the source to DI by pressing the input channel Source selector until the DI LED is lit.

3 On the front of the Mbox 2, turn the Mix control fully left to Input.

4 On the front of the Mbox 2, carefully turn the Gain control to the right to increase the input level of your microphone signal.

5 If the incoming signal is too loud, press the Pad switch to engage the –20 dB pad.

Connecting Instruments to the Mbox 2

Mbox 2 provides two input types (DI and Line) that correspond to the different signal strengths output by different types of instruments.

**DI Input** Instruments such as electric guitar or electric bass that usually have a lower level of output than line level instruments use the DI (“Direct Inject”) input.

**Line Input** Line level devices, including electronic audio sources such as mixers, samplers, keyboards, turntables, and synthesizers use the Line input.

Connecting Electric Guitar or Bass

To use a guitar with Mbox 2:

1 On the back of the Mbox 2, plug your guitar cable into one of the DI inputs.
2 On the front of the Mbox 2, set the Source to DI by pressing the Mic/DI switch until the DI LED is lit.

3 On the front of the Mbox 2, turn the Mix control fully left to Input.

4 On the front of the Mbox 2, carefully turn the Gain control to the right to increase the input level of your guitar.

💡 When you record a guitar (or any mono instrument that uses only one source input), you will hear the sound in only one side of the stereo field. Pushing the “mono” button on the front of the Mbox 2 brings the sound from one side of the stereo field to both sides. The Mono switch does not affect the audio being recorded. It only affects how you hear your input to the Mbox 2.

### Connecting Keyboards and Mixers

**To use a keyboard or mixer with Mbox 2:**

1. Plug your keyboard, mixer, or other audio source into either the Input 1 or Input 2 Line (TRS) inputs on your Mbox 2. If your source is stereo (such as a stereo keyboard or the stereo output from a mixer), connect the left channel (often the white plug) to Input 1, and right channel (often the red plug) to Input 2.

2. On the front of the Mbox 2, set the Source to Mic by pressing the Mic/DI switch until the Mic LED is lit.

3. On the front of the Mbox 2, turn the Mix control fully left to Input.

⚠️ If your keyboard has unbalanced outputs, use the Mbox 2’s DI inputs. Refer to your keyboard’s documentation.
4 Set your instrument's volume to its optimal level. For example, the optimal level for most keyboards is between 80% and 100% of maximum volume.

5 On the front of the Mbox 2, carefully turn the Gain control to the right to increase the input level of your keyboard.

Digital Input and Output

Mbox 2 provides digital inputs and outputs for S/PDIF format digital audio. The two channels of S/PDIF digital input can be used in combination with the two analog inputs (for a total of four simultaneous input channels).

Connecting Digital Devices

To connect a S/PDIF device to Mbox 2:

1 Use two 75-ohm coaxial cables with male RCA connectors on both ends (purchased separately).

2 Connect the device's S/PDIF output to Mbox 2’s S/PDIF input port, and the device's S/PDIF input to Mbox 2’s S/PDIF output port.

💡 To configure Mbox 2 to record from a digital source, choose Setups > Hardware Setup in Pro Tools, then select S/PDIF in the Clock Source.

Using S/PDIF Input

To configure Pro Tools to record from a S/PDIF device:

1 Choose Setups > Hardware Setup.

2 Select S/PDIF from the Clock Source pop-up menu. On the front panel, the S/PDIF LED lights to indicate this setting.

3 Click OK.

4 On the recording track, select the appropriate stereo or mono S/PDIF source from the track Input selector.

S/PDIF Mirroring

Pro Tools LE uses S/PDIF mirroring to automatically “mirror” the audio that is sent to Line Outputs 1 and 2 on the S/PDIF RCA outputs. This is useful, for example, if you are monitoring a mix using your Line Outputs, and also recording the same source to an external S/PDIF device.
MIDI Connections

The two MIDI ports on Mbox 2 let you take advantage of all the MIDI features of Pro Tools LE, including recording and editing MIDI tracks.

If you need additional MIDI ports you can add a compatible MIDI interface. USB MIDI interfaces work effectively with Pro Tools systems on Windows or Mac. Serial MIDI interfaces are supported on Windows systems only.

⚠️ Only USB MIDI interfaces are compatible with Pro Tools systems for Mac OS X. Modem-to-serial port adapters and serial MIDI devices are not supported.

To connect your MIDI device to Mbox 2:

1. Connect a standard 5-pin MIDI cable from the MIDI Out port of your device to the MIDI In port on the back of Mbox 2.

2. Connect another MIDI cable from the MIDI In port of your device to the MIDI Out port on the back of Mbox 2.

Monitoring MIDI Instruments with Mbox 2

If you have a MIDI instrument that has analog outputs, you can connect it to Mbox 2 to monitor its output.

To connect your MIDI instrument for monitoring in Pro Tools:

- Connect the MIDI instrument’s audio outputs to the Line (TRS) inputs on your Mbox 2.
Appendix A

Configuring AMS (Mac OS X Only)

Audio MIDI Setup

Pro Tools recognizes the ports on your MIDI interface as generic ports. With Mac OS X, you use Apple’s Audio MIDI Setup (AMS) utility to identify external MIDI devices connected to your MIDI interface and configure your MIDI studio for use with Pro Tools.

To configure your MIDI studio in AMS:

1. Do one of the following:
   - Launch Audio MIDI Setup (located in Macintosh HD/Applications/Utilities).
   - or -
   - In Pro Tools, choose Setup > MIDI > MIDI Studio.

2. Click MIDI Devices. AMS scans your system for connected MIDI interfaces. If your MIDI interface is properly connected, it appears in the window with each of its ports numbered.

3. For any MIDI devices connected to the MIDI interface, click Add Device. A new external device icon with the default MIDI keyboard image will appear.

4. Drag the new device icon to a convenient location within the window.
5 Connect the MIDI device to the MIDI interface by clicking the arrow for the appropriate output port of the device and dragging a connection or “cable” to the input arrow of the corresponding port of the MIDI interface.

6 Click the arrow for the appropriate input port of the device and drag a cable to the output arrow of the corresponding port of the MIDI interface.

7 Repeat steps 3–6 for each MIDI device in your MIDI setup.

To configure an external MIDI device:

1 Select the external device icon and click Show Info (or double-click the new device icon).

2 Select a manufacturer and model for the new device from the corresponding pop-up menus. (If the Manufacturer and Model pop-up menus do not provide a name for your particular device, you can type a name.)

For Manufacturer and Model names, AMS refers to one or more files with the suffix “.middev” in the directory Root/Library/Audio/MIDI Devices. Pro Tools installs a file that contains information for many commercially available MIDI devices, named “Digidesign Device List.middev.” If the Manufacturer or Model names for any of your external MIDI devices is not available in the AMS Manufacturer and Model pop-up menus, you can add them by editing the .middev file in any text editor (such as TextEdit).
3 Click the More Properties arrow to expand the dialog, then enable the appropriate MIDI channels (1–16) for the Transmits and Receives options. (These determine which channels the device will use to send and receive MIDI.)

4 Click the device image. The window expands to show images for various MIDI devices (such as keyboards, modules, interfaces, and mixers). Select an icon for your device.

5 Click OK.

The device names you enter appear as MIDI input and output choices in Pro Tools.
**MIDI Patch Name Support**

Pro Tools supports XML (Extensible Markup Language) for storing and importing patch names for you external MIDI devices. Pro Tools installs MIDI patch name files (.midnam) for the factory default patch names of many common MIDI devices. These files reside in directories, sorted by manufacturer, in Macintosh HD/Library/Audio/MIDI Patch Names/Digidesign.

**To import MIDI patch names into Pro Tools:**

1. Verify the MIDI Device name in the Audio MIDI Setup window (see “Audio MIDI Setup” on page 43).

2. Verify the Instrument or MIDI track output is correctly assigned to the MIDI device.

3. Click the Instrument or MIDI track Patch Select button.

4. In the Patch Select dialog, click Change.

5. In the Open dialog, navigate to /Library/Audio/MIDI Patch Names/Digidesign/<name of manufacturer>, and select the MIDI Patch Name file (.midnam) for the MIDI device.

6. Click Open.

The Patch Select dialog is populated with patch names and the Patch Name Bank pop-up menu appears in the upper left hand corner of the window.

Once patch names have been imported into Pro Tools, they are available for that MIDI device in all sessions.

**To clear patch names:**

- In the Patch Select dialog, click Clear, and the click Done.

MIDI patch name files (.midnam) can be edited in any text editor, or you can use third-party patch librarian and editor software to create your own custom patch names.
appendix b

Configuring MIDI Studio Setup (Windows Only)

MIDI Studio Setup

MIDI Studio Setup (MSS) lets you configure the MIDI controllers and sound modules that are connected to your system, and control the routing of MIDI data between your MIDI equipment and Pro Tools.

MSS automatically finds MIDI interfaces, and lets you specify a custom name for each of the MIDI ports within the MIDI Studio Setup document.

MSS also supports XML-based patch file names for storing and importing patch names for your external MIDI devices.

Entire MIDI Studio Setup configurations created within MSS can be imported and exported.

MIDI Studio Setup Window

The MIDI Studio Setup window is organized into three sections. Interface controls are at the top of the window. All the currently defined instruments are displayed in the Instrument Name list on the left side of the window. A detailed view of MIDI parameters is shown in the Properties section on the right.
**Interface Controls**

**Create** Adds a new instrument to the Instrument Name list.

**Delete** Deletes the instrument or instruments selected in the Instrument Name list.

**Import** Imports an existing MIDI Studio Setup file.

**Export** Exports the current MIDI Studio Setup file.

**Show Duplicate Emulated Ports** When this option is selected and you are using a MIDI interface that supports timestamping (such as MIDI I/O), in addition to the MIDI ports on Mbox 2, the MIDI Studio setup window shows both the DirectMusic time-stamped output ports, and non-stamped duplicate emulated output ports.

⚠️ Some MIDI Interfaces will not properly load or unload their drivers unless you quit and re-launch Pro Tools. Check the documentation that came with your MIDI interface for more information.

**Instrument List**

The Instrument list contains all the currently defined instruments. Selecting an instrument in the list displays that instrument’s properties in the Properties section of the window.

**Properties Section**

The Properties section lets you edit information for new instruments, or instrument currently selected in the Instrument list.

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument Name</td>
</tr>
<tr>
<td>Manufacturer</td>
</tr>
<tr>
<td>Model</td>
</tr>
<tr>
<td>Input Port</td>
</tr>
<tr>
<td>Output Port</td>
</tr>
</tbody>
</table>

**MIDI Studio Setup Properties section**

When a previously defined instrument is selected in the Instrument list, the Properties section changes to reflect the properties of the selected instrument.

**To define an instrument with MIDI Studio Setup:**

1. Choose Setup > MIDI > MIDI Studio.
2. Click Create.
3. In the Instrument Name field, type the name of your instrument, and press Enter.
   
   If you do not enter an instrument name, the Instrument Name field will automatically inherit information from the Manufacturer and Model pop-up menu.

4. Set a manufacturer and model for the new device from the corresponding pop-up menus. If the Manufacturer and Model pop-up menus do not provide a name for your particular device, select None.
5. From the Input pop-up menu, select the input port on your MIDI interface that is connected to the MIDI Out of your instrument.
6 From the Output pop-up menu, select the output port on your MIDI interface that is connected to the MIDI In of your instrument.

7 Enable the appropriate MIDI channels (1–16) for the Send Channels and Receive Channels options (These determine which channels send and receive MIDI.)

**Instrument Name**

The Instrument Name field shows the user-definable instrument name for the currently selected instrument.

**Manufacturer**

The Manufacturer pop-up menu provides a list of MIDI equipment manufacturers. This list is derived from the XML-based MIDI device files.

**Model**

The Model pop-up menu provides a list of MIDI devices, filtered by the manufacturer name. This list is derived from the XML-based MIDI device files provided with your Pro Tools installation.

For more information, see “MIDI Patch Name Support” on page 49.

**Input Port**

The Input Port pop-up menu displays a list of available MIDI interface input ports. Inputs will include Mbox 2 and any additional MIDI interfaces enabled on your system. The MIDI interface port that is set and displayed here is the port through which MIDI data is sent from the external MIDI device specified in the Instrument Name field into your MIDI interface.

If you set the input port to None, the defined instrument will not appear as a choice in a MIDI Input selector.

**Output Port**

The Output Port pop-up menu displays a list of available MIDI interface output ports. The port set and displayed here is the port through which MIDI data is sent from your MIDI interface to the MIDI device specified in the Instrument Name field.

If you set the output port to None, the defined instrument will not appear as a choice in a MIDI Output selector.

**Send Channels**

The Send Channels grid sets the send channels for the MIDI device specified in the Instrument Name field.

**Receive Channels**

The Receive Channels grid sets the receive channels for the MIDI device specified in the Instrument Name field.

**MIDI Patch Name Support**

Pro Tools supports XML (Extensible Markup Language) for storing and importing patch names for your external MIDI devices. Pro Tools installs MIDI patch name files (.midnam) for the factory default patch names of many common MIDI devices. These files reside in directories, sorted by manufacturer, in C:\Program Files\Common Files\Digidesign\MIDI Patch Names\Digidesign.
To import MIDI patch names into Pro Tools:

1. Verify the MIDI Device name in the MIDI Studio Setup window (see “MIDI Studio Setup” on page 47).

2. Verify the Instrument or MIDI track output is correctly assigned to the MIDI device.

3. Click the Instrument or MIDI track Patch Select button.

4. In the Patch Select dialog, click Change.

5. In the Open dialog, navigate to C:\Program Files\Common Files\Digidesign\MIDI Patch Names\Digidesign\<name of manufacturer>, and select the MIDI Patch Name file (.midnam) for the MIDI device.

6. Click Open.

The Patch Select dialog is populated with patch names and the Patch Name Bank pop-up menu appears in the upper left hand corner of the window.

Patch Select dialog with patch names

Once patch names have been imported into Pro Tools, they are available for that MIDI device in all sessions.

To clear patch names:

- In the Patch Select dialog, click Clear and then click Done.

MIDI patch name files (.midnam) can be edited in any text editor, or you can use third-party patch librarian and editor software to create your own custom patch names.
It is recommended that you start with a newly formatted external or secondary internal audio drive. You should also periodically defragment your audio drive to ensure continued system performance.

Avoid Recording to the System Drive

Recording to your system drive is not recommended. Recording and playback on a system drive may result in lower track counts or fewer plug-ins.

Supported Drive Formats and Drive Types

Drive Formats

Mac Mac systems should use drives formatted with HFS+ or HFS file system only.

HFS drives are supported as Transfer drives only.

Windows Windows XP systems should use drives formatted as NTFS only.

Windows systems can also support Mac drives formatted with HFS+ system (also commonly referred to as Mac OS Extended). Refer to the Pro Tools Reference Guide for more information (Help > Pro Tools Reference Guide).

Hard drive performance depends on factors including system configuration, number of tracks, session sample rate, density of edits, and the use of crossfades and other processes such as Beat Detective in a session.

For complete hard drive requirements, visit our website at:

www.digidesign.com/compatibility
**SCSI Hard Drives**

We recommend qualified SCSI hard drives and a qualified SCSI host bus adapter (HBA) card or (on Windows systems) a qualified built-in SCSI HBA connector on the motherboard.

For complete information on track count and the supported number and configuration of SCSI drives, visit our website at:

www.digidesign.com/compatibility

**FireWire Hard Drives**

We recommend qualified FireWire drives and (on Windows systems) a qualified FireWire host adapter.

For complete information on track count and the supported number and configuration of FireWire drives, visit our website at:

www.digidesign.com/compatibility

**IDE/ATA/SATA Hard Drives**

A qualified internal IDE/ATA/SATA drive may be used as a dedicated audio drive.

For complete information on track count with internal drives, visit our website at:

www.digidesign.com/compatibility

---

### Formatting an Audio Drive

#### Formatting Mac Audio Drives

For optimum performance, audio drives should be formatted as Mac OS Extended (Journaled).

**To format an audio drive:**

1. Launch the Disk Utility application, located in Macintosh HD/Applications/Utilities.

2. Click the Erase tab.

3. Select the drive you want to initialize in the column on the left side of the window.

4. Choose the Mac OS Extended (Journaled) format.

   ![Disk Utility (Mac OS X)](image)

   **Do not choose the “Case-Sensitive” format option. Pro Tools will not operate properly with case-sensitive formatted drives.**

5. Type a name for the new volume.

6. If you plan to connect the drive to a Mac OS 9 computer, select Install Mac OS 9 Drivers.

7. Click Erase.

The drive appears on the Desktop with the new volume name.
Formatting Windows Audio Drives

For optimal performance, audio drives should be formatted as NTFS.

⚠️ *Pro Tools only supports Basic drive types. Do not convert the drive to a Dynamic type.*

To format an audio drive:

1. Right-click Computer (Windows Vista) or My Computer (Windows XP) and choose Manage.
2. Under Storage, choose Disk Management.

3. If the volume is “Healthy,” do the following:

💡 *Healthy volumes are volumes that have previously been partitioned and formatted.*

- In the Disk Management window, right-click the hard drive you will use for audio and choose Format.
- In the Format window, name the volume.
- Choose a file system. For optimum performance, audio drives should be formatted as NTFS.
- Select Perform a quick format.
- Make sure Enable file and folder compression is not selected.
- Set the Allocation unit size to Default.
- Click OK.

4. If the volume is “Unallocated,” do the following:

- In the Disk Management window, Right-click the hard drive you will use for audio and choose New Partition.
- In the New Partition Wizard window, click Next.
- When prompted, select the partition type.

💡 *We recommend using Primary partitions, instead of Extended partitions.*

- Follow the on-screen instructions to select a partition size and other partition settings.
- When prompted, choose a file system. For optimum performance, audio drives should be formatted as NTFS.
- Select Perform a quick format.
- Make sure Enable file and folder compression is not selected.
- Set the Allocation unit size to Default.
- Click OK.

---

Partitioning Drives

Partitioning creates a logical volume or volumes on a physical drive, almost as if you were creating virtual hard drives. Partitions can then be formatted with the appropriate file system (NTFS for Windows, HFS+ for Mac).

⚠️ *Mac OS allows drives larger than 4096 MB to be seen as whole volumes. Drives must be initialized with a disk utility that recognizes the 2 terabyte limit. Single Pro Tools audio files cannot exceed 3.4 GB in size.*

⚠️ *Windows XP allows drives formatted with the NTFS file system to be seen as whole volumes. Single Pro Tools audio files cannot exceed 3.4 GB in size.*
Seek Times on Partitioned Drives

Seek times are actually faster on partitioned drives (assuming that reads and writes are performed on a single partition), since the heads only have to seek within the partition boundaries, rather than the whole capacity of the drive.

Smaller partitions perform faster than larger partitions, but this comes at the expense of contiguous storage space. When you partition a drive, you will need to find the compromise that best suits your performance and storage requirements.

Avoid distributing audio files within a session over different partitions on the same drive since this will adversely affect drive performance.

Defragmenting an Audio Drive

Mac Systems

When working with larger files (such as video), you can limit fragmentation by backing up your important files to another disk, erasing the files from the original hard disk, then copying the files back, instead of doing a defragmentation.

Window Systems

Periodically defragment audio drives to maintain system performance.

For maximum recording and playback efficiency, data should be written to your hard drive in a contiguous fashion—minimizing the seek requirements to playback the data. Unfortunately, your computer can’t always store the sound files in this way and must write to disk wherever it can find space.

In multitrack recording, audio tracks are written in discrete files, spaced evenly across the disk. While fragmentation of individual files may be zero, the tracks may be far enough apart that playback will still be very seek-intensive. Also, the remaining free space on the disk will be discontinuous, increasing the likelihood of file fragmentation on subsequent record passes.

Increased fragmentation increases the chance of disk errors, which can interfere with playback of audio, and result in performance errors.

💡 On Windows, to avoid fragmentation, format drives with higher cluster sizes (such as 32K).

Optimizing (Defragmenting) Drives

To prevent fragmentation, you can optimize your drive, which rearranges your files into a contiguous format. Most optimizing software lets you run a check on a drive to find out the percentage of fragmentation. If your drive shows moderate to heavy fragmentation, you should consider optimizing it.

If you use your system for intensive editing, or if you frequently delete audio or fade files from your hard drive, you may need to optimize your drives on a weekly basis, or even every few days, since it doesn’t take long for even a large hard drive to become fragmented.

Backing Up Data Before Optimizing

Since your files will be rewritten by the optimization process, always make a backup copy of the data on your hard drive before you optimize it. You should also use a hard drive utility to find and repair any problems before optimizing data or re-initializing your drives. If there is any damage to your hard drive’s directories prior to optimizing, serious data loss may result.
Defragmenting Windows Audio Drives

To defragment an audio drive (Windows Vista):
1. Choose Start > Control Panel.
2. Click System and Maintenance.
3. Click Performance Information and Tools.
4. Click Advanced Tools.
5. Click Open Disk Defragmenter.
6. In the Disk Defragmenter window, click the Defragment Now button.

⚠️ The Defragment Now command defragments all your hard drives. This can take a lot of time, especially on systems with multiple drives.

Advanced users can use the command line tool Defrag.exe to defragment individual drives. See your Windows Vista documentation for more information.

To defragment an audio drive (Windows XP):
1. Right-click My Computer and choose Manage.
2. Under Storage, choose Disk Defragmenter.
3. In the Disk Defragmenter window, choose the drive you want to defragment.
4. Click the Defragment button and follow the on-screen instructions.

When defragmenting is complete, close the Computer Management window.

Using Mac Drives on Windows Systems

Pro Tools for Windows lets you record and play back sessions directly from a Mac-formatted (HFS+) drive connected to a Windows system. This functionality requires that all Mac session and audio files be stored on Mac-formatted drives.

During Pro Tools installation, make sure to select the Mac HFS+ Disk Support option. This option lets your Pro Tools system read, write, record, and play back using Mac-formatted HFS+ disks.

For information on using the Mac HFS+ Disk Support option, see the HFS+ Disk Support Option Guide.

For information on sharing sessions between Mac and Windows systems, see the Pro Tools Reference Guide (Help > Pro Tools Reference Guide).

Formatting and Maintaining HFS+ Drives

To format and partition any drives as HFS+, connect the drives to a Mac computer and use the Apple OS X Disk Utility.
Hard Disk Storage Space

Mono audio tracks recorded with 16-bit resolution at 44.1 kHz (CD quality) require approximately 5 MB of hard disk space per minute. The same tracks recorded with 24-bit resolution require about 7.5 MB per minute.

Stereo audio tracks recorded with 16-bit resolution at 44.1 kHz (CD quality) require approximately 10 MB of hard disk space per minute. The same tracks recorded with 24-bit resolution require about 15 MB per minute.

Table 4 lists the required disk space for certain track numbers and track lengths, to help you estimate your hard disk usage.

Table 4. Required hard drive space for audio tracks (44.1 kHz and 48 kHz sessions shown)

<table>
<thead>
<tr>
<th>Number of Tracks and Length</th>
<th>16-bit at 44.1 kHz</th>
<th>16-bit at 48 kHz</th>
<th>24-bit at 44.1 kHz</th>
<th>24-bit at 48 kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 mono track, 1 minute</td>
<td>5 MB</td>
<td>5.5 MB</td>
<td>7.5 MB</td>
<td>8.2 MB</td>
</tr>
<tr>
<td>1 stereo track (or two mono tracks), 5 minutes</td>
<td>50 MB</td>
<td>55 MB</td>
<td>75 MB</td>
<td>83 MB</td>
</tr>
<tr>
<td>1 stereo track (or two mono tracks), 60 minutes</td>
<td>600 MB</td>
<td>662 MB</td>
<td>900 MB</td>
<td>991 MB</td>
</tr>
<tr>
<td>24 mono tracks, 5 minutes</td>
<td>600 MB</td>
<td>662 MB</td>
<td>900 MB</td>
<td>991 MB</td>
</tr>
<tr>
<td>24 mono tracks, 60 minutes</td>
<td>7 GB</td>
<td>7.8 GB</td>
<td>10.5 GB</td>
<td>11.6 GB</td>
</tr>
<tr>
<td>32 mono tracks, 5 minutes</td>
<td>800 MB</td>
<td>883 MB</td>
<td>1.2 GB</td>
<td>1.3 GB</td>
</tr>
<tr>
<td>32 mono tracks, 60 minutes</td>
<td>9.4 GB</td>
<td>10.4 GB</td>
<td>14 GB</td>
<td>15.4 GB</td>
</tr>
</tbody>
</table>
Troubleshooting

**Backing Up Your Work**

It is highly recommended that you back up your work on a regular basis, and especially before making changes to your system configuration.

**Backing Up Your Session Data**

Back up your session and audio data frequently. There are a variety of media that are suited to back up projects of various sizes, from automated tape backup systems to high-capacity optical drives, or to CD burners.

The best way to back up an entire session is to use the Save Copy In command. This command lets you save the session file and all of its associated files to a new location.

💡 You can also use the Auto Save Backup feature (in the Operation Preferences page) to have Pro Tools automatically save backups of the session file while you work.

**Backing Up Your System Configuration**

After configuring your system and Pro Tools, you should save an image of your system drive using a backup utility such as Norton Ghost (Windows) or Bombich Carbon Copy Cloner (Mac). By doing this, you can quickly restore your system configuration and settings if you encounter any problems.
Common Issues

Pro Tools Won’t Launch

Problem
When you double-click the Pro Tools application or a Pro Tools session file, Pro Tools doesn’t launch, or displays an error message.

Possible Solutions
◆ Check to be sure your computer has the required amount of RAM to launch Pro Tools.
◆ Try a complete restart. Turn off your audio interfaces, computer peripherals and your computer, and then turn them on again in the proper sequence.
◆ If you tried to launch Pro Tools by double-clicking a Pro Tools session file, do the following:
  • Close any error message.
  • Double-click the Pro Tools application.
  • In Pro Tools, choose File > Open Session to open the session.
◆ Reinstall the Pro Tools application, using the Pro Tools Installer disc.

Audio Interface Is Not Recognized

Problem
When you launch Pro Tools it does not recognize an audio interface, or a connected audio interface is not available.

Possible Solutions
◆ Turn off your computer and check to be sure your cables are properly and securely connected to your computer and to your audio interface.
◆ Verify that your Hardware Setup dialog settings are correct.

Performance Factors

There are several conditions that may adversely affect the performance of Pro Tools. These include:

Network Connections Close any network connections unless you are using them for network interchange of audio data.

Background Applications Any software utilities that run in the background or generate disk activity, such as virus protection, disk optimization, or file savers, should be turned off or removed.

Screen Savers Screen saver software should be completely disabled on your computer before running Pro Tools.

Power Saver Features Some automatic power saver features, such as those that spin down the system hard drive, can affect Pro Tools performance. These features should be turned off.
Before You Call Technical Support

Register Your System

Register your purchase immediately after reviewing the Digidesign Registration Information Card included with every Pro Tools system. Registering your purchase is the only way you become eligible to receive complimentary technical support and future upgrade offers. Registering is one of the most important steps to complete as a new user.

Gather Important Information

We want to help you resolve problems as quickly and efficiently as possible. If you have the following information handy when you contact Technical Support, it will make the diagnosis of your problem easier. Take a few minutes to collect the following basic information:

System Information

Computer

- Make, model, processor speed
- Amount of system RAM
- Operating system (version of Windows or Mac OS)
- Any Drivers, Disk Utilities, or other system-related applications you may have installed

Digidesign Hardware

- Type of cards, interfaces, or peripherals

Hard Drives

- Make, Model
- Drive size (GB)
- Drive speed (RPM)
- Drive type (SCSI, FireWire, IDE/ATA)
- Utility used to format the drive
- Number and size of partitions on the drive

Digidesign Software

- Pro Tools software version
- Plug-in versions
- Other Digidesign software
- Additional plug-ins from Digidesign Development Partners

Other Hardware

Refer to the manufacturer’s documentation for operational details.

The most common hardware additions include:

- 1394 (FireWire) cards for Windows systems (manufacturer, model)
- Video Capture cards (manufacturer, model)

To verify that your hardware is qualified for use with your Pro Tools system, refer to the latest compatibility information on our website (www.digidesign.com/compatibility).

Other Software

If you are using other audio or video applications, refer to the manufacturer’s documentation for operational details.

Make note of any other software that was running when a problem occurred.
Diagnostic Information

Note any DAE errors or other error codes you encounter. Additionally, note the ability to reproduce the problem under different conditions, for example, with another session, or after changing settings (such as the Hardware Buffer Size).
Resources

Whether you are new to Pro Tools or just starting out with your new system, we encourage you to read and utilize the many guides that Pro Tools provides. There are also useful online resources available, giving you everything from Pro Tools tips to Pro Tools answers.

About the Pro Tools Guides

In addition to any printed guides included with your system, PDF versions of the printed guides and many additional Pro Tools guides and Read Mes are installed automatically during Pro Tools installation (see “Documentation Installed Automatically with Pro Tools” on page 62).

Printed copies of the Pro Tools Reference Guide and other guides in the Pro Tools guide set can be purchased separately from the DigiStore (www.digidesign.com).

Printed Setup Guide

This printed Setup Guide for your system gives you detailed instructions for setting up and configuring software and hardware for optimum performance.

Printed Getting Started with Pro Tools Guide

The printed Getting Started with Pro Tools LE has tutorials on using Pro Tools (such as recording in a Pro Tools session, importing audio from a CD, and creating an audio CD from a Pro Tools session).

Guides Accessible in Pro Tools

The main Pro Tools guides are accessible from the Pro Tools Help menu. (Choose Help, then select a guide.)

These include:

- **Shortcuts Guide**, which provides a complete list of keyboard and Right-click shortcuts for Pro Tools.
- **DigiRack Plug-ins Guide**, which describes the DigiRack plug-ins included with Pro Tools for both real-time and file-based audio processing.
- **Pro Tools Menus Guide**, which covers all the Pro Tools on-screen menus.
Documentation Installed Automatically with Pro Tools

When you install Pro Tools, you get useful PDF versions of many Pro Tools guides and Read Mes. This documentation can be found in the following locations:

**Mac** Applications/Digidesign/Documentation

**Windows** C:\Program Files\Digidesign\Documentation

To view or print PDF guides, you can use Adobe Reader or Apple Preview (Mac only).

Read Me Files

These contain late-breaking information and known issues pertaining to Pro Tools software and hardware configurations. Read Me files are installed in Documentation folder when you install Pro Tools.

Training and Education Study on your own using courses available online or find out how you can learn in a classroom setting at a certified Pro Tools training center.

Products and Developers Learn about our products; download demo software or learn about our Development Partners and their plug-ins, applications, and hardware.

News and Events Get the our latest product news or sign up for a Pro Tools demo.

Pro Tools Accelerated Videos Watch the series of free tutorial videos. Accelerated Videos are designed to help you get up and running with Pro Tools and its plug-ins quickly.

Helpful Online Resources

Once you get going, here are some helpful online resources:

- Get useful information, help, and tips from the worldwide community of Pro Tools users at Digidesign User Conference (DUC). Go to: http://duc.digidesign.com
- For questions about installation, visit our online Answerbase. Go to: http://www.digidesign.com/answerbase
- If you can’t find your answer on the DUC or Answerbase, contact our email support. Go to: http://www.digidesign.com/tsr

About www.digidesign.com

Our website (www.digidesign.com) is your best online source for information to help you get the most out of your Pro Tools system. The following are just a few of the services and features available.

Product Registration Register your purchase online.

Support and Downloads Contact Digidesign Technical Support or Customer Service; download software updates and the latest online manuals; browse the Compatibility documents for system requirements; search the online Answerbase; or join the worldwide Pro Tools community on the Digidesign User Conference.
A
ASIO driver (Windows) 13
audio
digital connections 41
audio drivers
ASIO driver (Windows) 13
CoreAudio driver (Mac) 7
WaveDriver (Windows) 13
Audio MIDI Setup (AMS) (Macintosh) 43
authorizing Pro Tools LE
Mac 7
Windows 12

C
Cache Size 20
Clean Uninstall (Mac) 8
Clock Source 22
and digital output 36
Internal setting 22
S/PDIF (digital) setting 22
connecting Mbox 2
Mac 6
CoreAudio driver (Mac) 7
CPU Usage Limit 17, 18

D
DAE Playback Buffer Size 19
DMA option (Windows), enabling 25
drive formatting
Mac 52
Windows 53
drive maintenance 51
drive requirements 3

E
Energy Saver (Mac), turning off 23

F
FireWire requirements 52

G
gain
headphones 29
input 31

H
hard drives
drive formats 51
FireWire requirements 52
formatting 52, 53, 52
IDE/ATA requirements 52
maintenance 51, 54
optimizing 54
partitioning 53
requirements 3
SCSI requirements 52
space requirements 56
Hardware Buffer Size 16
headphones
gain control 29
output 29
I/O Setup
  Windows 22
IDE/ATA requirements 52
Ignore Errors During Playback/Record option 19
indicators
  peak level 31
  S/PDIF 29
  USB connection 29
input and output connectors 32
inputs
  analog 33
  digital 32
  gain 31
  monitoring 30
installing Pro Tools LE
  Mac 5
  Windows 9
installing QuickTime (Windows) 11

journaling (Mac), enabling 25

key commands 3

latency
  Hardware Buffer Size 16
  see monitoring

Mbox 2
  back panel 32
  connecting (Mac) 6
  features 1, 29
  removing the handle 31
MIDI
  connections 42
  requirements 2
  setup (Macintosh) 43, 47
MIDI Studio Setup (MSS) (Windows) 47
Minimize Additional I/O Latency option 19
mix control (Mbox 2) 30
monitoring
  when overdubbing 30
  zero latency 30
mono switch 30

network cards (Windows), disabling 27
network connections 58

optimizing hard drives 54
outputs
  digital 32
  Monitor outputs 33
  S/PDIF mirroring 41

partitioning hard drives 53
Patch Select dialog
  Macintosh 46
  Windows 50
peak indicators 31
phantom power 38
  indicator 31
  when to use 31, 37
Playback Engine
  RTAS Processors setting 17
Plug-in Streaming Buffer 21
Plug-in Streaming Buffer Size 20
plug-ins
  multiprocessors 17
  RTAS Processors setting 17
power
  management settings (Windows) 26
Pro Tools
  demo session (Windows) 8, 13
  removing (Windows) 8, 14
Pro Tools LE
  capabilities 2, 16
  installing (Mac) 5, 9
processor performance (Mac) 23
Processor Scheduling performance (Windows) 28

QuickTime
  installing (Windows) 11
R
ratio control (Mbox 2) 30
recording
digital inputs 41
removing Pro Tools
Windows 8, 14
RTAS Processors setting 17

S
S/PDIF 32
  input indicator 29
  mirroring 41
Safe Uninstall (Mac) 8
Sample Rate 21
screen savers 58
SCSI requirements 52
Software Update (Mac), turning off 23
sources
  analog 33
  DI 33
digital 32
  line 33
  microphone 33
  selecting 31
Spotlight indexing (Mac), disabling 25
Startup items (Windows), disabling 28
Stereo Width control 40, 42
system
  optional optimizations (Windows) 27
  recommended optimizations (Windows) 27, 25
  shutting down 15
system optimization
  Mac 23
  Windows 27
system settings
  Cache Size 20, 22, 18
  Hardware Buffer Size 16
  I/O Setup 22
  Plug-in Streaming Buffer 21, 20
  Sample Rate 21

T
technical support
  product registration required 59
TRS 37

U
uninstalling Pro Tools
Windows 8, 14
USB connection indicator 29
User Account Control (UAC)
  disabling 27

W
WaveDriver (Windows) 13
website 62